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Résumé du sujet 

Ainsi, dans ce projet de stage, le sujet d'étude s’est porté sur les vitesses de déshydratation des feuilles 
et de réhydratation des tissus clés impliqués dans la survie et la récupération d’une espèce prairiale à 
un stress hydrique sévère, le Dactyle aggloméré. Cette étude a pour but de comprendre les 
mécanismes hydrauliques impliqués dans sa résistance et la survie à une sécheresse extrême.  
L’hypothèse testée est celle d’un déterminisme hydraulique de la résistance et de la survie à la 
sécheresse des feuilles et des méristèmes foliaires du Dactyle, ces derniers étant des tissus clés de la 
survie de cette espèce aux sécheresses extrêmes. Pour cela deux méthodes seront utilisées : la 
méthode optique qui va permettre de suivre la dynamique temporelle de l’embolie des vaisseaux au 
sein des feuilles et la tomographie aux rayons X qui va permettre de visualiser l’embolie des vaisseaux 
dans les méristèmes foliaires et les racines.   
Le pari de ce projet est de savoir si, grâce à ces deux méthodes,  
- il existe une segmentation de vulnérabilité à l’embolie entre les différents organes d’une talle 
(feuilles, méristèmes foliaires, racines) 
- la dynamique de déshydratation des feuilles et des méristèmes est déterminée par rupture 
hydraulique de leurs vaisseaux, 
- la récupération des méristèmes (et donc des plantes) est liée à leur réhydratation par les racines via 
un réseau hydraulique racinaire redevenu fonctionnel ou à une humectation locale des méristèmes 
foliaires liée aux pluies.  
  
 
 

Abstract  

Thus, in this project, the subject of study focused on leaf dehydration and rehydration rates of key 
tissues involved in the survival and recovery of a grassland species subjected to severe water stress, 
cockfoot. This study aims to understand the hydraulic mechanisms involved in its resistance and 
survival at extreme drought. 
 
The hypothesis tested is that of a hydraulic determinism of the resistance and survival to drought of 
leaves and leaf meristems of Dactylis, the latter being key tissues of the survival of this species to 
extreme droughts. For this purpose, two methods will be used: the optical method that will make it 
possible to follow the temporal dynamics of the embolism of the vessels within the leaves and the X-
ray tomography which will make it possible to visualize the embolism of the vessels in the leaf 
meristems and the roots. 
   
The challenge of this project is to know if, thanks to these two methods, 
- there is a segmentation of vulnerability to embolism between the different organs of a tiller (leaves, 
leaf meristems, roots) 
the dehydration dynamics of the leaves and meristems is determined by hydraulic rupture of their 
vessels, 
- The recovery of meristems (and therefore plants) is related to their rehydration by the roots via a 
root network hydraulically functional or to a local moistening of the leaf meristems related to the rains. 
  
In the following weeks, various tests will be carried out, using the optical method to monitor plants 
undergoing dehydration and rehydration as well as tests using tomography 
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Liste des abréviations :  

INRA : Institut national de la recherche agronomique 

UMR UREP : Unité mixte de Recherche sur l'Ecosystème Prairial 

UMR PIAF : Unité Mixte de Recherche de Physique Intégrative de l’Arbre en environnement Fluctuant 

P50 : Potentiel hydrique du xylème induisant 50% de perte de conductance hydraulique dans les 
vaisseaux 

PLC : Percentage of loss of conductivity (pourcentage de perte de conductivité) 
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Présentation de l’organisme d’accueil   
  

L’Institut National de la Recherche Agronomique (INRA)  

En 1946 a été fondé l’Institut National de la Recherche Agronomique (INRA) suite à la Seconde Guerre 
Mondiale. L’INRA a été créé dans le but d’atteindre l’autosuffisance alimentaire de la France. Il a ainsi 
permis d’enclencher une nouvelle dynamique agricole en proposant des améliorations qu’elles soient 
variétales, en termes de techniques culturales ou encore de génétiques animales. Ceci permit ainsi à 
la France de redevenir autonome sur le plan alimentaire dès les années 1960. Dans les années 80 grâce 
aux nouvelles technologies, l’INRA peut se concentrer sur la biologie moléculaire et les 
biotechnologies ; les Organismes Génétiquement Modifiés (OGM) végétaux et les transplantations 
d’embryons animaux apparaissent : l’INRA est l’institut pionnier dans ce domaine. Présentement, dans 
le contexte actuel d’augmentation de la population mondiale, le contrôle des maladies et des 
ravageurs des plantes cultivées permet d’apporter une sécurisation de la production agricole en 
qualité et en quantité. Cela doit s’accompagner de moyens de contrôle moins dépendants des 
pesticides et plus respectueux de l’environnement. C’est donc le défi de l’Inra de mener des recherches 
pour réconcilier production agricole et durabilité en croisant différentes disciplines dont la génétique, 
l’agronomie, l’écologie, les sciences sociales et économiques… 

Le centre de recherche Auvergne-Rhône-Alpes :  

Réparti sur les deux ensembles Auvergne et Rhône-Alpes, le centre Inra Auvergne-Rhône-Alpes 
développe des recherches multidisciplinaires dans les différents domaines de la biologie intégrative, 
des relations élevage-produits-territoires, de l’écologie des systèmes microbiens et aquatiques et de 
la nutrition préventive. Il constitue environ 10 % du potentiel de recherche national de l'INRA. 
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Figure 1 : Inra, Site de Crouel, Clermont-Ferrand (63) 

L’UREP et le PIAF  
  
Mon stage s’est effectué au sein de l’INRA de Clermont-Ferrand (figure 1) en collaboration avec deux 
unités : l’UREP et le PIAF. 

L'Unité Mixte de Recherche sur l'Ecosystème Prairial (UMR-UREP) étudie l’agroécologie de 
l’écosystème prairial dans un contexte de changement global, notamment les changements 
climatiques et les pratiques de gestion. L'unité possède une expertise internationale dans les domaines 
des cycles du carbone et de l'azote (bilan de gaz à effet de serre et la séquestration de carbone), 
l’assemblage des communautés végétales, les interactions biotiques (plantes – sol – herbivores) et 
leurs conséquences sur le fonctionnement des prairies. 

L'Unité Mixte de Recherche de Physique Intégrative de l’Arbre en environnement Fluctuant (UMR 
PIAF) fait des recherches portant sur les réponses des arbres aux facteurs de l’environnement 
(hydrique, lumineux, mécanique, minéral, thermique) déterminant leur acclimatation ou survie, en 
prenant en compte les aspects architecturaux et fonctionnels et en travaillant sur l'ensemble du cycle 
annuel. 

 

  

Source : Chloé Pasquier 



Exploration des mécanismes de résistance et de survie au stress hydrique extrême du Dactyle aggloméré, une 
poacée prairiale 

 
  Page 7 sur 47 
PASQUIER – Génie Biologique Option Agronomie – 2017/2019  

Contexte général  

En raison du changement climatique, qui correspond à l’augmentation des concentrations en gaz à 
effet de serre, la température moyenne de l’air du globe a subi une élévation d’environ 0,6°C au XXe 
siècle. De plus le changement climatique s’accompagne d’une augmentation de la fréquence et de 
l’intensité des évènements considérés comme extrêmes : tempêtes, canicules, sécheresses, 
inondations…Ces évènements extrêmes, représentés notamment par des vagues de chaleur et des 
sécheresses intenses, vont avoir des conséquences négatives sur la dynamique et le fonctionnement 
des écosystèmes (Zwicke, 2013). Pour réduire la vulnérabilité des écosystèmes, plusieurs leviers 
d’action sont possibles comme trouver des populations et espèces adaptées et mettre en place des 
pratiques agricoles elles aussi adaptées. 

La sécheresse édaphique (sécheresse du sol) survient sur une période pendant laquelle les sols sont 
secs en raison de précipitations qui sont inférieures à la moyenne. Elle peut également advenir même 
si les pluies sont intenses mais avec une fréquence plus faible ou dans le cas d’une évapotranspiration 
qui serait alors supérieure à la normale. Cette sécheresse est donc due à un déficit de précipitations 
durant la saison de végétation (au printemps et en été) ce qui conduit à un manque d’eau disponible 
dans le sol pour les plantes (Dai, 2011).  

On peut définir la sécheresse par son intensité et sa durée. L’intensité peut être calculée par la quantité 
minimale de précipitations reçue par l’écosystème, l’humidité du sol minimale ou le déficit de stock 
d’eau dans le sol.  
La sécheresse peut être observée à court terme (sur quelques semaines, mois) avec une absence de 
précipitations (sécheresse dite de « pulse ») mais aussi observée à plus long terme (sur quelques mois, 
année) avec des déficits de précipitations prolongées au cours desquels il y a des évènements de 
précipitations (sécheresse dite « chronique »).  
La nature permanente des sécheresses dites « chroniques » signifie que des conditions défavorables 
sont observées à long-terme avec uniquement de courtes durées de reprises, alors que la nature « 
aigüe » des sécheresses dites « pulses » induit des périodes nettement séparées de stress intenses. 
Dans le cas de la sécheresse chronique, le stress atteint des niveaux moins extrêmes mais il va durer 
plus longtemps avec de brèves périodes de récupération tandis que dans le cas de la sécheresse pulse, 
la période de récupération est plus longue (De Boeck et al., 2017). 

On parle de sécheresse car la transpiration du couvert végétale diminue beaucoup et la croissance 
s’arrête alors que l’évapotranspiration est élevée (Granier et al., 1999; Knapp et al., 2001). 

La littérature montre que la sécheresse limite fortement la croissance des plantes et ainsi affecte le 
service de fourniture qui est la production fourragère pour les prairies. Cependant, quelques travaux 
montrent dans certains cas une absence de réduction de la production prairiale (Grime et al., 2000; 
Jentsch et al., 2011). Cette absence de réponse a été attribuée à une combinaison de facteurs 
impliquant la composition de la communauté végétale, la fertilité du milieu, la gestion des prairies 
(Grime et al., 2008) ou à la quantité et la fréquence de pluie reçue par les prairies (Cherwin et Knapp, 
2012).  

L’importance des prairies est due au fait qu’elles constituent un écosystème majeur et l’un des 
principaux biomes à l’échelle mondiale. Les prairies couvrent environ 40 % de la surface agricole utile 
(SAU) ce qui correspond à 18 % du territoire national (soit environ 9,3 millions d’hectares) (Huyghe et 
al., 2014). Elles sont composées d’espèces herbacées à croissance rapide ce qui les rend facilement 
manipulables. La végétation qui est dense et continue, plus ou moins haute, inclue en général des 
Poacées, des Fabacées ainsi que d’autres plantes herbacées dicotylédones non fixatrices d’azote qui 
appartiennent à plusieurs familles botaniques. Les prairies permanentes ont une végétation composée 
d’espèces fourragères pérennes qui peuvent persister indéfiniment si les conditions de gestion le 
permettent (Allen et al., 2011). Cela-dit, des espèces ligneuses peuvent en outre être présentes. Selon 
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les zones géographiques où les prairies sont situées et la gestion qui y est appliquée, elles ont une 
production plus ou moins élevée et se développent dans des milieux moyennement ou très riches en 
nutriments. 

Pour la plupart d’entre elles, ce sont des écosystèmes qui sont façonnés, maintenus et exploités par 
l’Homme afin de produire l’alimentation des espèces herbivores domestiquées, et cela par gestion de 
fauche et de pâture. Les prairies n’ayant pas été converties en terre arable ou culture permanente 
depuis 5 ans ou plus, sont dites permanentes, pour un temps inférieur à 5 ans, elles sont dites 
temporaires.  

Les services écosystémiques sont définis comme des « avantages et fonctions écologiques associés aux 
écosystèmes naturels conférant un bénéfice pour l’Homme » (Plantureux et al., 2016). Ces différents 
services ont été classés par l’Évaluation des Écosystèmes pour le Millénaire (MEA : Millennium 
Ecosystem Assessment) en 2005 en quatre grands types (figure 2) :  

- Services de support ou de soutien : ce sont les services nécessaires à la production des autres 
services, c'est-à-dire qui créent les conditions de base au développement de la vie sur Terre 
(formation des sols, production primaire, air respirable, etc.). Leurs effets sont indirects ou 
apparaissent sur le long terme ; 

- Services d'approvisionnement ou de production : ce sont les services correspondant aux 
produits, potentiellement commercialisables, obtenus à partir des écosystèmes (nourriture, 
eau potable, fibres, combustible, produits biochimiques et pharmaceutiques, etc.) ; 

- Services de régulation : ce sont les services permettant de modérer ou réguler les phénomènes 
naturels (régulation du climat, de l'érosion, des parasites, etc.) ; 

- Services culturels : ce sont les bénéfices non-matériels que l'humanité peut tirer des 
écosystèmes, à travers un enrichissement spirituel ou le développement cognitif des peuples 
(patrimoine, esthétisme, éducation, religion, etc.).  
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Figure 2 : Tableaux représentant les différents services 

Les flèches représentées sur ce schéma illustrent les liens les plus courants entre services 
écosystémiques et composantes du bien-être humain. Leur épaisseur représente l'intensité du lien, 
tandis que leur couleur correspond au degré d'intervention possible de facteurs socio-économique. 
Par exemple, s'il est possible d'acheter un produit ou service de remplacement à la place de celui 
attendu, l'influence des facteurs socio-économiques est faible, et la couleur des flèches est claire. 
L'intensité des liens et le potentiel de médiation diffèrent suivant les écosystèmes et les régions.  

Ainsi, les prairies jouent un rôle essentiel dans les prestations de nombreux services écosystémiques 
(stockage de carbone, niveau de biodiversité, atténuation du changement climatique, rétention de 
nutriments…), elles sont dites multifonctionnelles (Plantureux et al., 2016). Cependant, un 
changement des conditions climatiques pourrait entrainer une altération du fonctionnement de 
l’écosystème prairial et pourrait affecter la restitution des services et en particulier le devenir de la 
production de fourrage. 

Toutefois, bien que certaines herbacées résistent à ces évènements climatiques, la dégradation et la 
baisse de la productivité des prairies pourraient, en raison de la sécheresse, devenir de plus en plus 
courant. En effet, la sécheresse a pour impact sur les plantes une réduction de leur productivité ou 
peut même mener à leur mort. En conséquence, la résilience des prairies à des sécheresses présente 
un enjeu important pour la production de fourrage en quantité et en qualité pour les systèmes 
d’élevage herbagers.  
Il n’existe pas de connaissances précises définissant la vitesse à laquelle les communautés végétales 
peuvent réagir et s’adapter aux changements environnementaux soudains et intenses, peu 
d’expériences ayant été réalisées afin d’étudier les mécanismes qui permettent la résistance et la 

Source : Évaluation des services rendus par les écosystèmes 
(Millenium Ecosystem Assesment, 2005)  
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récupération des services écosystémiques face à des sécheresses. Il est donc important et nécessaire 
d’approfondir un tel axe.  

Contrairement aux espèces ligneuses pour lesquels la capacité à survivre à une sécheresse intense est 
en grande partie due à leur résistance à l’embolie, les processus concernant la résistance et la survie 
ainsi que la capacité de récupération des espèces herbacés sont moins connus. En effet, on sait que 
les prairies survivent à des stress forts, étant composées de nombreuses espèces pérennes qui 
subissent donc un certain nombre de période de stress et de récupération durant leur cycle de vie. 
Elles doivent donc présenter des stratégies variées et fonctionnelles afin de faire face à des épisodes 
de sécheresse pouvant être modérés ou bien sévères (Zwicke et al., 2015), des stratégies qui doivent 
comporter d’importantes différences comme les arbres. Mais il y a peu de connaissances concernant 
les mécanismes impliqués dans la survie et la récupération bien qu’un lien entre l'évitement de la 
déshydratation par absorption d'eau a pu être relié avec les espèces ayant des racines profondes (> 
1,2 m) et une masse racinaire élevée (> 4 kg m−3) (Zwicke et al., 2015). 

 

En conséquence, afin de préserver les prairies on pourrait adapter leur composition floristique en 
améliorant nos connaissances sur les mécanismes d’adaptation et d’acclimatation au manque d’eau 
des espèces végétales herbacées, telles que les poacées, qui sont dus aux événements climatiques et 
en particulier les épisodes de sécheresse extrême. 

Dans cette étude, nous étudierons ainsi le cas du Dactyle aggloméré, une poacée qui est l’une des 
principales graminées fourragères en raison de sa haute productivité et qui a une bonne résistance à 
la sécheresse, afin d’observer les mécanismes qui lui permettent de survivre et de récupérer après une 
sécheresse.  

 Le rôle de l’eau pour les plantes 

Il faut donc tout d’abord se placer pour cela dans un contexte climatique particulier avec de longues 
périodes sans pluie et donc de sécheresse avec de brefs à-coups symbolisés par des épisodes de pluie. 
Ce contexte climatique inhabituel est une épreuve pour les végétaux qui ont besoin d’eau.  

En effet l’eau est un élément clé chez les végétaux, qui contiennent plus de 80% d’eau dans leurs tissus, 
et dont les cellules sont également pleines d’eau. Toutes les réactions biochimiques dans les plantes 
nécessitent de l’eau pour avoir lieu. L’eau permet la réalisation de différents mécanismes 
physiologiques :  

- l’eau absorbée par les racines avec des minéraux est utilisée pour leur croissance 
- la photosynthèse avec l’assimilation de CO2 au niveau des feuilles 
- la transpiration avec la perte d’H2O par les stomates 

Ces trois fonctions se réalisent en cas de conditions hydriques favorables, mais lorsque celles-ci ne le 
sont pas les végétaux peuvent subir un stress hydrique, conduisant à une réduction de ces trois 
fonctions.  

Il est important de connaître le stress hydrique que subissent les plantes, en effet, lors d’un stress 
hydrique dont la durée se prolonge, d’importants dégâts sont causés et les plantes deviennent plus 
vulnérables aux ravages dus aux insectes et maladies. Les plantes subissant un stress hydrique sont en 
manque d’eau, et cela peut impacter sur la croissance de celles-ci, sur le rendement des cultures ainsi 
que sur la qualité de la production. Le potentiel hydrique permet de mesurer le stress hydrique subi 
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par les plantes. Il correspond à l’énergie nécessaire pour extraire une unité de volume d’eau hors de 
l’échantillon. Il représente l’état hydrique d’un organe et sera mesuré au cours du stage. 
 

Évènement de cavitation (signification, impacts)  
 
Les plantes vasculaires assurent le transport de l’eau du sol jusqu’à l’atmosphère, c’est-à-dire que l'eau 
traverse la plante en partant des racines avant d'être réémise dans l'atmosphère sous forme de vapeur 
par les feuilles. Dans les plantes, il existe différents modes de transport. Le xylème va conduire la sève 
brute, l’eau et les sels minéraux prélevés par les racines dans le sol (flux ascendant) et le phloème va 
conduire la sève élaborée, l’eau et les sucres produits par les feuilles (flux descendants). 

Ce premier mode de transfert a pour moteur la transpiration foliaire qui se fait essentiellement grâce 
à l’énergie solaire. Celle-ci va fournir à l’eau la quantité d’énergie requise afin qu’elle puisse passer de 
l’état liquide à l’état de vapeur une fois arrivée au niveau des feuilles.  

Ce transfert est initié par l’absorption de l’eau du sol par les racines grâce aux poils absorbants. L’eau 
va alors suivre un itinéraire dans le cortex en dehors des vaisseaux des racines, couplé à des potentiels 
hydriques croissants puis va entrer dans les vaisseaux au niveau de la stèle. Une fois dans le système 
vasculaire, l’eau parvient alors aux différents organes dont les feuilles où la transpiration a lieu.  

La transpiration, moteur principal du transfert de l’eau à travers la plante, est majoritairement régulée 
par la fermeture et ouverture des stomates. Elle exerce également une tension sur la sève. En cas de 
tension trop importante, par exemple lors d’une sécheresse, une vaporisation soudaine de la colonne 
d’eau sous tension peut alors avoir lieu, constituant le phénomène de cavitation. Le terme de 
cavitation est originairement appliqué dans le domaine de la physique où sont décrits des phénomènes 
identiques dans des systèmes mettant en place des hélices ou des canalisations hydrauliques. La 
conséquence de la cavitation est l’arrêt de la propagation de la sève brute ce qui entraine une embolie 
gazeuse, une situation caractérisée par la présence de bulles d’air dans les vaisseaux passant d’un 
élément conducteur fonctionnel à un élément conducteur non fonctionnel. Cela peut entrainer de 
graves conséquences physiologiques pouvant aller jusqu’à la mort de certaines parties voire même de 
toute la plante (Delzon et Cochard 2014).  
Le pourcentage d’embolie correspond au pourcentage de perte de conductance hydraulique qui est 
mesurable dans la plante par différentes techniques. La mesure de  la P50 (valeur clef de la 
vulnérabilité d’une espèce à la cavitation), représente le potentiel hydrique du xylème induisant 50% 
de perte de conductance.  

Cependant, certaines espèces développent des mécanismes de survie bien que leurs vaisseaux soient 
embolisés. Ceux-ci peuvent redevenir fonctionnels sous l’influence d’une pression osmotique au de la 
tige ou des racines capables de reprendre leurs fonctions. Ou bien encore, c’est une croissance, soit la 
formation de nouveaux vaisseaux qui permet de conduire de nouveau le flux de transpiration.  

Différents travaux de la littérature (Lens et al 2016, Volaire et al 2018) montrent que la vulnérabilité à 
la cavitation fluctue considérablement, entre des espèces ou même au sein d’une même espèce. La 
variabilité intraspécifique peut être d’origine génétique (différence entre génotypes), ou liée à une 
plasticité phénotypique, soit la capacité d’un organisme à exprimer divers phénotypes à partir d’un 
même génotype donné selon l’organe, la phénologie ou bien les conditions environnementales. 

Nous pouvons nous demander comment les espèces herbacées comme les poacées vivent les deux 
phases de réponses à la sécheresse, tout d’abord la résistance pendant laquelle le stress se produit, et 
durant laquelle la question de survie se pose, toutefois on l’évalue surtout après réhydratation. Soit 



Exploration des mécanismes de résistance et de survie au stress hydrique extrême du Dactyle aggloméré, une 
poacée prairiale 

 
  Page 12 sur 47 
PASQUIER – Génie Biologique Option Agronomie – 2017/2019  

pendant la phase de récupération. La tomographie permet de visualiser les vaisseaux embolisés donc 
l’état de survie.  

Différents travaux ont été réalisés avec différentes techniques comme le Xyl’em et le Cavitron 
(Cochard, 2002) sur des tiges de poacées prairiales afin de mesurer leur capacité à résister à la 
cavitation et de la lier ou non à leur capacité de résistance à la sécheresse. Ces méthodes sont toutefois 
très contraignantes, par exemple le Cavitron nécessite en effet des mesures sur différentes tiges 
florales d’une espèce qui doivent être au bon stade de maturation, chaque tige correspondant à un 
point pour créer une courbe permettant de définir la P50 de l’espèce étudiée. D’où l’intérêt de 
développer de nouvelles techniques plus simples.  

Lors de ce stage, une étude a été menée sur les effets d’une déshydratation complète des feuilles sur 
les évènements de cavitation dans les feuilles et la récupération des méristèmes foliaires et des racines 
après un stress hydrique conduisant à la mortalité des feuilles, cela afin de localiser la résorption 
d’embolie dans les différents tissus lors de la reprise des flux d’eau dans la plante.  

Dans un 1er cas, on étudie la cinétique d’embolie des vaisseaux des feuilles à un stress hydrique 
croissant, afin de déterminer le potentiel hydrique lorsque 50% d’embolie est mesurée (P50) et le 
comparer avec la valeur obtenue dans une autre étude (Lens et al 2016). 

Dans un 2ème cas, sur un nombre limité de plantes, on a étudié la récupération des méristèmes 
foliaires et des racines après réhydratation des plantes dont les feuilles étaient complètement 
embolisées afin d’observer la présence ou non de vaisseaux embolisés. Un contrastant a été utilisé 
pour améliorer la visualisation de l’eau dans les vaisseaux et leur fonctionnalité en plongeant les 
racines dans la solution du contrastant.  
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Matériel et Méthodes 
 

Matériel Végétal utilisé 
  
Les tests ont été effectués sur du Dactyle aggloméré, Dactylis glomerata L., une espèce de plante 
appartenant à la famille des Poacées dont la floraison est entre avril et septembre. Comme toutes les 
poacées prairiales, le dactyle est une plante qui se multiplie par voie végétative, c’est-à-dire qu’elle 
peut se passer de reproduction sexuée pour se multiplier. En effet elle se reproduit par tallage et forme 
ainsi un ensemble de talles filles à partir d’une talle mère, formant une structure appelée touffe. Au 
sein d’une même plante on a donc une cinétique d’installation des feuilles qui lui permet d’avoir une 
première, deuxième et troisième feuille. Bien qu’appartenant à la même espèce, des facteurs ne sont 
pas contrôlables en raison de différences d’âge des feuilles, de taille des plantes ou bien encore de 
différences de connexions hydrauliques entre la talle mère et les talles filles.  

Des espèces du Dactyle sont cultivées en tant que plantes fourragères en raison de leur richesse en 
protéine. Selon le Gnis, c’est une espèce fourragère qui peut produire de manière abondante entre 5 
et 10 ans si les conditions sont favorables et qui accepte des sols séchants avec peu d’intrants. Quelle 
que soit sa fonction, le dactyle est une graminée réputée pour sa longueur de racine lui permettant un 
accès plus facilité aux ressources du sol en profondeur telles que l’eau et les minéraux, la rendant ainsi 
plus résistante aux sécheresses extrêmes estivales.  

 

Figure 3 : Rhizotrons installés en serre (cadre rouge) 

Dans notre cas les plantes sont issues d’un pool de graines issues d’une population de D. glomerata 
prélevée en moyenne montagne (Theix dans le Puy-de-Dôme (63), à une altitude de 800m) et ont été 
cultivées en rhizotron (figure 3). C’est un mini-bac (figure 4) constitué d’une plaque en plastique 
transparente rectangulaire mesurant 50 cm x 30 cm x 0.2 cm, d’une toile en nylon (maille 100µm) 

Source : Chloé Pasquier  

Rhizotrons 
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permettant d’isoler les racines du sol et d’un support en plastique mesurant 50.5 cm x 30 cm x 0.3 cm 
et 1,5 cm de profondeur en prenant en compte les « bras » du support.  

 

Figure 4 : Présentation des éléments constituants un rhizotron 

Dans chacun des rhizotrons, trois talles ont été repiquées (figure 5). Le substrat utilisé est un 
« terreau » qui est placé entre le tissu et le support tandis que la talle est positionnée en haut du 
rhizotron entre le tissu et la plaque avec un peu de terreau afin d’aider au départ des racines. Ainsi ce 
système permet d’observer les systèmes racinaires et permet, pour notre étude, de prélever les 
plantes sans casser les racines.  

Source : Chloé Pasquier  
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Figure 5 : 3 plantes dans un rhizotron 

Il y avait un total de 12 rhizotrons dont 36 plantes. Dix rhizotrons ont été utilisés pour suivre la 
dynamique de déshydratation des feuilles et deux rhizotrons pour suivre la récupération après un 
stress hydrique sévère d’une durée d’environ 1 mois et demi. 

Tout d’abord conditionnées en chambre de culture de février à début avril afin d’accélérer la 
croissance, les plantes ont été déplacées ensuite en serre (figure 3) après avoir été touchées par des 
maladies ressemblant à de la rouille ou à des mycètes. Les feuilles malades ont été coupées afin 
d’éviter une contamination entre les différentes plantes.  

 

1. Etude de la déshydratation des feuilles pour mesurer leur dynamique d’embolie 
  
 Pour cette étude, 27 plantes ont été utilisées et mesurées lors de 16 dates différentes. 
 

Scanner et Psychromètres  
 

Source : Chloé Pasquier  



Exploration des mécanismes de résistance et de survie au stress hydrique extrême du Dactyle aggloméré, une 
poacée prairiale 

 
  Page 16 sur 47 
PASQUIER – Génie Biologique Option Agronomie – 2017/2019  

 
Figure 6 : Installation d’un scanner simultanément à un psychromètre 

 
-Principe du scanner : Un scanner (Epson, V800) va analyser les feuilles scotchées à plat et de manière 
parallèle au rayon lumineux. Le scan se fait par transparence. Les échantillons reçoivent les deux 
rayons lumineux : par le capot et par le bas et la lumière reçue va alors être transformée en un signal 
électrique par un ou plusieurs capteurs. Ce signal est ainsi numérisé et va constituer une image 
matricielle des feuilles qui est transférée à l'ordinateur, pour y être ensuite sauvegardée, traitée ou 
analysée.  
 
 
-Mise en fonctionnement  du scanner : Le scanner va permettre d’obtenir des images (résolution de 
1200 dpi, niveau de gris, 8bit) toutes les 5 minutes permettant de suivre l’évolution de l’embolie d’une 
feuille durant sa déshydratation : d’un état complètement hydraté (soit à 0 % embolie) à un état 
complètement déshydraté (soit à 100% embolie). Les images scannées sont enregistrées 
automatiquement et analysées par la suite avec le logiciel ImageJ (Fiji app – ImageJ – fiji-win64). La 
durée de chaque expérimentation a varié entre 11h et 45h, avec une moyenne de 20h. Deux scanners 
ont été utilisés en parallèle permettant de suivre 2 plantes en parallèle. Les scanners sont lancés de 
manière simultanée avec les psychromètres.  

 Avant la mise en place des plantes sur le scanner, je choisis les paramètres de scan que je veux, ainsi 
que le dossier de destination et le nom des images qui vont être numérisées.  

Préparation des plantes pour le scanner (figure 6) : Chaque plante est extraite des rhizotrons sans 
casser les racines, mise dans un bac d’eau afin d’éviter une déshydratation des racines entrainant la 
création d’évènements de cavitation non désirés et une évolution du potentiel hydrique dans les 
feuilles. Les racines sont lavées pour enlever la terre. Deux feuilles, ayant approximativement le même 
âge, sont placées et scotchées de manière horizontale sur chaque scanner. Un aperçu sera alors réalisé 
permettant de visualiser le placement des feuilles. Les zones souhaitées à scanner seront alors 
sélectionnées et délimitées avec le logiciel de scan, puis les scans sont lancés tandis que les racines 
sont sorties de l’eau et enroulées dans du papier humide afin d’éviter une déshydratation trop rapide.  

 
Analyse des images (figures 7 et 8) : A la fin de la déshydratation des feuilles, les images sont 

Source : Chloé Pasquier  

Feuilles scannées 
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récupérées et analysées grâce au logiciel ImageJ permettant de dénombrer dans le temps les 
évènements de cavitation qu’a subi chaque feuille scannée, en les visualisant et en les analysant. 
ImageJ est un programme de traitement d'images open source pour des données d'images 
multidimensionnelles axées sur l'imagerie scientifique. Ce logiciel nous permet d’obtenir en nombre 
de pixels les évènements de cavitation en fonction du temps (voir Tuto cf. Annexe 1).  
Toutefois avant de pouvoir mesurer les évènements de cavitation, les images sont nettoyées afin 
d’enlever le bruit (figure 9 et 10), qui correspond à des mouvements de la feuille causés par la 
déshydratation qui a pour conséquence sa rétractation.  
Grâce au logiciel ImageJ, chaque évènement est mesuré en pixel. Le premier évènement sera donc 
égal à x pixels, le deuxième à y, etc. Le cumul d’évènements est la somme des pixels de tous les 
évènements répertoriés. La somme totale de pixel est donc égale à 100. (La somme totale de pixel de 
cavitation divisée par la somme totale de pixel de la surface de la feuille multipliée par 100 est égale 
au pourcentage de la feuille qui est cavité).  

Les aires de chaque surface ont également été calculées en pixel grâce à ImageJ. La conversion en cm 
s’est faite grâce à une règle de trois, 5 cm correspondant à X pixels, soit Y pixels correspondant à Z cm. 
 
 

 

 

Figure 7 : Observation d’un évènement de cavitation 
Source : Chloé Pasquier 

 

 

 
Figure 8 : Observation successive du vaisseau ayant subi un évènement de cavitation (figure 7)  

Source : Chloé Pasquier 

Sur les figures 7 et 8, le rectangle du haut permet la visualisation du limbe avec les stries 
horizontales qui sont les vaisseaux dont le principal (le plus gros ; veine centrale) et les autres plus 
petits qui sont parallèles 

L’évènement de cavitation se détecte par une différence subtile de niveaux de gris entre deux images 
(formation de bulle d’air) 

Le rectangle du bas représente l’analyse d’image faisant ressortir les évènements de cavitation. 
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Figure 9 : Observation d’un évènement de cavitation en présence de bruit avant nettoyage (rectangle du centre) 
Source : Chloé Pasquier 

 

 

Figure 10 : Observation du même évènement de cavitation (figure 9) après nettoyage, le nettoyage est effectué sur le 
rectangle du bas 

Source : Chloé Pasquier 

 
-Mesure du potentiel hydrique d’une feuille : Psychromètres à point de rosée et chambre à pression  

Le psychromètre utilisé (PSY1-Stem, ICT International PtyLtd) est un appareil permettant de mesurer 
l’état hydrique des plantes, qui utilise le principe de l’effet Peltier : un courant continu est appliqué et 
circule dans une succession de semi-conducteurs reliés entre eux (cellules Peltier). L'ensemble est pris 
en sandwich entre deux plaques d'un matériau conducteur de chaleur. Le thermocouple de Type T est 
composé de deux métaux différents, l'une de ces plaques en cuivre se charge positivement et 
s'échauffe, l'autre en Constantan (alliage de cuivre et de nickel) se charge négativement et refroidit. 
Cette différence permettra de créer une goutte par effet de condensation et qui sera proportionnelle 
à l’humidité présente dans la chambre. La mesure obtenue sera alors convertie en potentiel hydrique. 
Lorsqu’une feuille est bien hydratée, le potentiel hydrique (exprimé en valeur négative) est proche de 
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0 MPa et lorsqu’une feuille est déshydratée, le potentiel hydrique devient très négatif et se rapproche 
de -8 MPa (valeur maximale mesurable par le psychromètre).  
 
Préparation des échantillons pour les mesures psychrométriques (figure 8) : Sur une feuille d’un âge 
similaire à celles positionnées sur le scanner, de la poudre de carbone est appliquée et légèrement 
frottée avant d’être enlevée afin de faciliter les échanges d’eau avec l’extérieur. La feuille sera ensuite 
placée au-dessus de la chambre, à l’endroit frotté, et fixée avec du scotch pour aider au maintien de 
celle-ci et avant de fermer le tout avec un « chapeau » plus adapté pour faire tenir le montage durant 
les mesures.  

 

Figure 11 : A gauche, observation du "chapeau" de base ; à droite : adaptation du "chapeau" 

 

Figure 12 : Schéma général avec le système de fixation présente ici avec une feuille 

 

-configuration du logiciel d’acquisition des mesures des psychromètres : Après avoir lancé le logiciel 
(ICT Instrument Device Chooser, version 1.0.6.7) et connecté les psychromètres à l’ordinateur, ceux-ci 
sont paramétrés de façon à prendre une mesure enregistrée sur le pc toutes les 15 minutes. Le 
« cooling time » sera d’abord réglé sur 10s puis sur 20s. Ce temps de refroidissement est nécessaire à 

Source : Chloé Pasquier  Source : http://au.ictinternational.com 

Source : Chloé Pasquier  
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la formation de la goutte dans la chambre, plus la plante sera déshydratée, plus la plante aura besoin 
d’un « cooling time » plus long pour parvenir à la formation de la goutte.  

-Psychromètre -> Les données obtenues permettent de suivre la cinétique du potentiel hydrique qui 
est mesuré en MPa lors du cycle de déshydratation de chaque feuille. 

 

 

Chambre à pression (PMS Instrument Company, modèle 1505D Pressure Chamber 
Instrument) 

  
Afin de vérifier les potentiels hydriques mesurés par les psychromètres lorsque les plantes sont bien 
hydratées et pour chaque plante scannée, une feuille est mesurée avec la chambre à pression. 

-Principe (figure 13) : Le principe consiste à appliquer une pression sur les parois d’une feuille, coupée 
et insérée dans une chambre hermétique. Elle y sera bloquée dans un bouchon où du mastic sera 
appliqué afin d’empêcher toute fuite d’air lorsque la pression sera appliquée sur le bout de feuille dans 
la chambre. Le bout de feuille en dehors sera placé sous lumière et loupe afin d’observer lorsque la 
sève sortira. La pression est assénée via un gaz inerte (azote) jusqu'à ce que la sève contenue dans la 
feuille apparaisse au niveau de la section transversale au niveau des vaisseaux. La pression, qui a été 
exercée, est lue sur un manomètre et correspond alors au potentiel hydrique de la feuille avant qu’elle 
soit coupée. Lors de l’utilisation de la chambre à pression, un essai à vide doit être réaliser afin de 
vérifier que l’appareil fonctionne correctement et conserve l’air dans la chambre sans fuite. 

Les feuilles sont récupérées sur les plantes utilisées pour les scans et les psychromètres. Une feuille 
sur chaque plant, d’un âge identique aux autres plantes, est prélevée. Sur chaque feuille prélevée, on 
coupe avec un scalpel juste au-dessus de l’oreillette afin d’avoir accès à une partie plus plate du limbe. 
Chacune des feuilles sera mise à son tour dans la chambre où elle sera bloquée de manière hermétique 
avec un bouchon, placé dans couvercle ayant une ouverture en forme de disque, la maintenant, et ne 
laissant qu’une petite partie en dehors de la chambre où sera observée avec une loupe l’arrivée de la 
sève grâce à la pression exercée sur la feuille. 



Exploration des mécanismes de résistance et de survie au stress hydrique extrême du Dactyle aggloméré, une 
poacée prairiale 

 
  Page 21 sur 47 
PASQUIER – Génie Biologique Option Agronomie – 2017/2019  

 

Figure 13 : Chambre à pression 

 

2. Etude de la récupération des plantes après un stress hydrique sévère 
 

Tomographie  
 
-Principe:  

La micro-tomographie à rayons X (Nanotom) est une méthode d’imagerie non destructive permettant 
de visualiser l’intérieur d’un objet en 3 dimensions (Choat et al, 2016). Dans notre cas, nous cherchons 
à visualiser les vaisseaux embolisés au niveau des méristèmes foliaires et des racines qui y sont 
attachées. 
Le principe repose sur la mesure de l’absorption d’un faisceau de rayons X après avoir traversé un 
échantillon. Lors d’une acquisition en micro-tomographie, l’échantillon est placé sur une platine de 
rotation entre la source de rayons et le détecteur 2D. L’objet est radiographié à différentes positions 
angulaires lors de sa rotation à 360° (figures 14 et 15). Par une opération mathématique dite de 
« reconstruction », une image numérique 3D est réalisée à partir de l’ensemble de ces clichés 2D. On 
peut ainsi accéder au cœur de l’échantillon permettant d’y situer toute particularité et d’y déterminer 
les caractéristiques internes sans découpe physique.  

Source : Chloé Pasquier  
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Figure 14 : Schématisation du fonctionnement de la micro-tomographie 

 
Figure 15 : Tomographe légendé 

  
-Mise en place méthodologique : Grâce à cette technique, nous pouvons donc étudier les échantillons 
préparés et analyser leurs états hydriques que ce soit au niveau des méristèmes foliaires et des racines. 
 

Source : Chloé Pasquier  

Source : https://tomoraw.fr  
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-> Phase de déshydratation : Lors de cette phase, les échantillons étudiés sont des échantillons qui 
sont passés au tomographe après avoir été scannés pendant environ 24 heures et qui étaient 
entièrement déshydratés, et qui avaient donc 100% d’embolie dans les feuilles.  

-Préparation du micro-tomographe : Lors de la préparation, nous en étions dans les conditions 
expérimentales suivantes : tension de 60kW et intensité de 240µA pour la source de rayons X en raison 
de la faible densité des échantillons d’origine biologique. Une distance de l’échantillon de 13mm avec 
la source de rayon X et une distance de 200mm entre l’échantillon et le détecteur ont permis d’obtenir 
une résolution de 3.3µm, la résolution du micro-tomographe allant de 0,9µm à 50 µm. De la cire sera 
mise à fondre préalablement l’expérience pour fixer l’échantillon.  
 
-Acquisition des échantillons : Une fois l’échantillon installé dans le micro-tomographe, l’acquisition 
d’image se fait avec le logiciel Phoenix Datosx 2, et le traitement d’image avec VG Studio MAX 2.1.   
 
-> Phase Réhydratation 
-Préparation du matériel (Avec et sans iode) : Une solution à base d’Iohexol (contrastant à base d’iode, 
polyol aromatique halogéné très soluble dans l'eau) de concentration 50mg/mL sera préparée. En 
étant diluée dans 100ml d’eau, l’iode pourra être absorbée par la plante si les tissus sont vivants, la 
présence de contrastant pourra être observée dans les tissus racinaires (cortex et stèle) et 
méristématiques des feuilles. 
 
-Acquisition des échantillons (figure 16) : Les deux plantes dont le méristème et les racines vont être 
observés sont placés dans un bécher contenant de la solution pour l’un et n’en contenant pas pour 
l’autre pour comparer les images obtenues avec et sans contrastant. Afin que le contrastant soit 
efficace, une durée de d’immersion d’environ 10h sera appliquée. 
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Figure 16 : Préparation des échantillons pour un passage au tomographe.  

L’une des plantes a des racines trempant dans l’iohexol (Poudre +). On peut observer 
des feuilles vertes en croissance pour les deux plantes, il est donc logique qu’il y ait des  

tissus vivants et du contrastant situé dans les racines et les méristèmes. 

 
-Préparation des échantillons (figure 17) : Afin de préparer cette technique il faut accéder au 
méristème de la talle mère choisie : on enlève toutes les autres talles autre que la talle mère (étape a). 
Ensuite, on va enlever les feuilles de la talle, la plus vieille feuille étant celle le plus à l’extérieur (les 
feuilles s’enroulent et poussent à l’intérieur de la feuille précédente) (étape b). Après avoir enlevé la 
dernière feuille et coupé légèrement les morceaux de feuilles restants, on obtient une sorte de cône 
mis à nu (étape c). Le cône et les racines doivent être relativement bien nettoyés de la terre afin de 
faciliter le passage au tomographe.  
Afin de pouvoir garder le méristème et les racines droits (position verticale), les deux vont être fixés 
sur une baguette en bois jouant le rôle de tuteur grâce à du parafilm, en laissant le méristème dépasser 
légèrement de la baguette (étape d). L’ensemble dépassant de la baguette sera trempé très 
rapidement dans la cire chaude puis tout de suite dans de l’eau froide afin qu’il n’y ait pas de la 
déshydratation (étape e). Du parafilm est ensuite appliqué sur la partie protégée par la cire et aussi 
autour des racines, gardées intactes (étape f).  

Source : Chloé Pasquier  
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Figure 17 : Différentes étapes de la préparation des échantillons avant un passage au tomographe 

 

 

Source : Chloé Pasquier  
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Résultats  
1. Dynamique de déshydratation des feuilles 

 
Pour chaque feuille placée dans un psychromètre, la dynamique temporelle du potentiel hydrique a 
été suivie (figure 18). Pour les exemples des dates du 13/05 et 16/05, le potentiel hydrique initial était 
de -1 MPa et -0.5 MPa, respectivement. Pour le 13/05, au bout de 19 et 16 heures, le potentiel hydrique 
est descendu à une valeur de -7.9 et -8.4 MPa, avec une pente moyenne de -0.43 MPa h-1. Pour le 
16/05, le potentiel hydrique a varié de -0.5 MPa à -6.8 et -7.95 MPa, avec une pente moyenne de -0.42 
MPa h-1.  

 

Figure 18 : Courbes du 15 et 16/05/2019 représentant la déshydratation des feuilles dans le temps 
Source : Chloé Pasquier 

La légende            symbolise la courbe dont les données sont issues du psychromètre relié au 
scanner appartenant au Piaf. La légende       symbolise donc quant à elle les données issues du 
psychromètre relié au scanner de l’Urep.  

Afin de vérifier la cohérence de la mesure, une mesure de potentiel hydrique est donc réalisée avec 
la chambre à pression qui permet de valider la concordance des mesures. La valeur obtenue avec la 
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chambre à pression correspond dans la majorité des cas à la moyenne des deux ou trois premières 
valeurs obtenues avec le psychromètre.  

Relation entre le pourcentage cumulée d’embolie et le potentiel hydrique des feuilles :  

Les évènements de cavitation, analysés avec le logiciel ImageJ à partir des images capturées toutes les 
5 minutes grâce au scanner, sont cumulés dans le temps.  

Avec les données de potentiel hydrique mesuré en parallèle avec un pas de temps de 15 minutes, on 
peut donc associer pour chaque pas de temps, une valeur d’embolie cumulée avec une valeur de 
potentiel hydrique. Ceci nous permet de construire des courbes reliant le pourcentage cumulée 
d’embolie en fonction du potentiel hydrique des feuilles. Les courbes sont tracées et ajustées suivant 
une fonction d’une sigmoïde : embolie cumulée (%) = 100 / (1 + exp(a( - b))), avec , le potentiel 
hydrique, a et b deux constantes. La valeur de 100 est utilisée pour représenter le maximum d’embolie. 
Le coefficient b détermine la position de la courbe en abscisse et donne le potentiel hydrique 
correspondant à 50% d’embolie (P50, MPa). Le coefficient a est relié à la pente de la courbe. 
La moyenne du cumul d’embolie des deux feuilles scannées a été utilisée pour construire les courbes 
présentées en figures 21 et 22. Le coefficient b donne directement la valeur P50 pour chacune de 
courbes (figure 23). La moyenne totale des P50 est égale -4.38 MPa avec un écart-type de 0.87. Lors 
de divers travaux comme celui réalisé par Volaire et al, en 2018 sur 12 populations de dactyle, la P50 
variait entre -3.06 à -6.36MPa. En 2016, Lens et al ont montré durant leur travail que l’espèce Dactylis 
glomerata origine France (moyenne montagne, et similaire à la population utilisée dans ce stage) avait 
une P50 de -4.1 MPa. On peut ainsi en déduire que les résultats obtenus lors de notre étude sont 
proches de ceux observés sur le dactyle aggloméré, malgré l’utilisation de méthodes différentes et 
d’organes différents. Pour Lens et al (2016) et Volaire et al (2018), des tiges florales ont été utilisées et 
mesurées avec un cavitron et un Xyle’m. La construction des courbes a été faite à partir de tiges 
différentes pour chaque point de la courbe, tandis que dans ce stage, la construction de la courbe a 
été faite avec deux feuilles d’une même plante.  

La méthode dite optique (scanner) semble donner des résultats cohérents et plus facile d’utilisation. 
Elle pourra être améliorer en mesurant sur la même feuille les événements de cavitation et le potentiel 
hydrique. Cependant, l’utilisation de la méthode fait l’hypothèse qu’au début de la déshydratation des 
plantes, aucun d’évènement de cavitation a eu lieu dans les feuilles.  

Pour chaque feuille, l’aire totale a été mesurée ainsi que le pourcentage d’aire des évènements 
accumulés qui y étaient détectés. On obtient, pour notre échantillon de 58 feuilles, une aire moyenne 
de 367cm² avec un écart-type de 147 cm² (incluant une grande variabilité) et une moyenne de 
pourcentage de 8.6% avec un écart-type de 4.2. Pour vérifier cela, l’existence d’une absence de relation 
(R2=0.0012) entre P50 de chaque feuille le pourcentage des évènements de cavitation cumulés 
correspondant (figure 20), permet de déduire qu’il n’y a pas d’effet du pourcentage sur la valeur des 
P50, ce qui aurait remis en cause la méthode.  
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Figure 19 : Pour chaque date, chaque scan et chaque feuille, sont présentées les valeurs de P50 et le % de surface de limbe 
embolisé 

Source : Chloé Pasquier 

:  

Figure 20 : Courbe représentant la P50 des feuilles scannées en fonction du pourcentage embolisé 
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Figure 21 : Moyenne de la P50 des feuilles pour chaque scanner du 30/04/19 au 27/05/19 
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Figure 22 : Moyenne de la P50 des feuilles pour chaque scanner du 30/04/19 au 27/05/19 
Source : Catherine Picon-Cochard 

 

 

Figure 23 : Tableau réunissant les moyennes des P50 en MPa obtenues pour les deux feuilles de chaque scanner 
Source : Chloé Pasquier 

 
-Tomographie : Visualisation de l’embolie dans les tissus 

Nous avons prélevé des plantes dont les feuilles étaient à 100% d’embolie (à la fin de l’expérience avec 
le scanner, figure 24).  
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Figure 24 : Plante à la fin de l’expérience avec le scanner 

Sur les images suivantes on peut voir des points gris à l’intérieur du méristème correspondant à de 
l’air. Lorsqu’il n’y a pas d’embolie, les points ne sont pas visibles. L’observation de l’anatomie des 
racines est également possible, cette observation amenant à conclure que les racines sont également 
embolisées en raison de la présence de points gris en leurs centres.  

Source : Catherine Picon-Cochard 
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Figure 25 : Observation d’une coupe de méristème de Dactyle embolisé à 100%, plan xy.  

Ces images permettent de confirmer que lorsque 100% d’embolie est observée dans les feuilles, elle 
est aussi présente dans les méristèmes foliaires et les racines.  

 

Partie réhydratation : 

Afin d’observer le méristème et les racines lors de la réhydratation, du contrastant a été utilisé. On 
peut observer sur les images la présence de contrastant au sein des vaisseaux (en rouge sur la figure 
26). Cependant, pas dans toutes les racines, surtout dans 3 racines sur les 7 observables. Pour le 
méristème (au centre), la présence de contrastant est plus homogène que pour les racines. Cependant, 
nous ne sommes pas sûr que le contrastant a diffusé par le réseau vasculaire des racines ou par contact 
direct avec la solution, bien que des précautions ont été prises de positionner la plante au-dessus de 
la solution (figure 16). 

Source : Pierre Conchon 
Pasquier  
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Figure 26 : Méristème et racines sur lesquels le contrastant est utilisé 
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Figure 27 : Observation 3D d’une coupe de méristème foliaire de Dactyle ayant été réhydraté et ayant absorbé du 
contrastant. Les pixels rouges correspondent aux tissus dans lesquels se trouve le contrastant, qui est passé dans les 

vaisseaux des racines (stèle) et les faisceaux du méristème foliaire. 

 

 

 

Source : Pierre Conchon 
Pasquier  
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Discussion et Perspectives  
  
-> Courbes : On peut relever un grand nombre de variations entre les différentes courbes représentant 
les évènements de cavitation en fonction du potentiel hydrique. Cela peut être dû au fait que les 
mesures étaient prises sur 3 feuilles différentes n’appartenant pas non plus à la même talle à chaque 
fois. La méthode utilisée est basée sur l’hypothèse que les 1ers évènements de cavitations observés 
correspondent vraiment à une totale absence de cavitation avec le début de la manipulation. Elle 
permet une visualisation de tous les vaisseaux mais les connexions latérales entre vaisseaux ne sont 
pas prises en compte, ce qui a comme conséquence une absence de relation entre la P50 d’une feuille 
et son pourcentage de surface embolisée. Afin de perfectionner les prochains travaux effectués sur les 
évènements de cavitation et le potentiel hydrique, il serait notable de réaliser les mesures avec les 
psychromètres et scanner sur la même feuille, cela induisant donc l’utilisation de scanner de taille plus 
réduite. Bien sûr il risque de se poser la question de la qualité de l’image selon la finesse des scans 
réalisés par le scanner réduit. Malgré cette variabilité, la valeur moyenne de P50 obtenue sur les 
feuilles est proche de celle mesurée dans deux autres études.  
L’étude a été effectuée sur une espèce parmi les nombreuses qui composent une communauté 
végétale, il serait donc intéressant d’en étudier d’autres afin de pouvoir faire des comparaisons entre 
les diverses espèces qui se trouvent dans un même milieu.  

-> Tomographie : Les échantillons observés avant la phase de réhydratation et sans contrastant ont 
montré des racines et des méristèmes embolisés, ainsi que les feuilles. Il y aurait une absence de 
segmentation de l’embolie chez le dactyle, c’est-à-dire que l’embolie se propagerait dans tous les 
organes et tissus de la plante. 

Tandis que pendant la phase de réhydratation, avec le contrastant, la mise en avant des vaisseaux 
fonctionnels de nouveau alors même que les plants étaient déshydratés depuis un mois, a pu être 
réalisée. Toutefois, les racines ayant été plongées entièrement dans la solution, on peut supposer qu’il 
y a eu un phénomène de diffusion et que le contrastant ne s’est donc pas entièrement déposé dans 
les vaisseaux de manière active. Lors de prochaines expériences sur la réhydratation, il semblerait 
convenable de ne mettre que les apex racinaires bien que cela soit compliqué en raison de la longueur 
conséquente des racines.  

-> Réhydratation : La réhydratation des 6 plants qui ont subi une déshydratation durant un mois a 
montré que certains des plants n’étaient pas morts et arrivaient à survivre à la sécheresse. En effet 
après quelques jours de réhydratation, de nouvelles feuilles sont apparues sur des plants avec le 
développement de nouvelles racines et des anciennes racines qui repartent et font de nouveaux des 
poils absorbants (figure 28).  
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Figure 28 :  Plants ayant de nouvelles feuilles, de nouvelles racines et d’anciennes racines qui repartent avec de nouveaux poils 
absorbants

Source : Chloé Pasquier  
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Réflexions personnelles + intérêts du stage  

Ce stage m’a appris beaucoup tant sur le plan professionnel que personnel. En effet il m’a permis 
d’observer et d’en apprendre plus sur le fonctionnement du monde de la recherche dans une unité 
mixte où enseignants-chercheurs, chercheurs et techniciens travaillent en collaboration sur des sujets 
appliqués et théoriques. Ce stage m’a également permis de réaliser et d’observer des manipulations 
que je n’aurais pu faire/voir en dehors de ce cadre de travail. J’ai également pris conscience que je 
pourrais être intéressée par le travail de recherche.  
De plus le travail effectué durant ce stage m’a apporté une capacité d’organisation du travail, de la 
mise en place des étapes de la recherche à la confirmation des résultats obtenus en passant par une 
grande partie de réflexion sur le travail accompli, dans quel but et vers quelles hypothèses, toute une 
méthode abordée pour effectuer des recherches dans de bonnes conditions. Grâce à ces trois mois, 
j’ai également pu confirmer et enrichir mes connaissances sur le fonctionnement des végétaux, 
notamment au niveau de leur fonctionnement hydraulique. 
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Annexe 1 : Tutoriel (en anglais) de l’utilisation d’imageJ afin de repérer, nettoyer et compter les 
évènements de cavitation.  
Open ImageJ  
 
Choose « File » -> « Import » -> « Image Sequence » -> Take pictures you want (in the option, choose 
Convert to 8-bit and Sort names numerically)  

Then, click on >> and on « OSOV Toolbox » -> (oval) -> Then click on the Green OSOV and on « Image 
difference V2 » and choose what you’re observing (here we choose « Leaf »).  

After that, click on Image -> Duplicate -> Duplicate stack  

Again Image but now choose « Adjust » -> Threshold  

At this point, click on Analyze -> Tools -> Synchronize Windows and check images you want to 
synchronise 

Now, you have to point out the events of cavitation on your images, to do that, you have to adapt the 
Threshold. After realize that, on a paper, note the number of where there are an event of cavitation 

Then, click again on Analyze -> Analyze particles and choose « Show Masks » 

Synchronize once more time  

You should have a binary image (in black and white), click on this window and after on « Process » -> 
Noise -> Remove outliers and « which outliers : Dark ». Here, you choose how you want to clean your 
images. The option « Preview » is really practical, use it !   

So, you have some images more clean, and to finalize that, click on the Oval and choose « Selection 
Brush Tool » and with right click or double click check Enable selection brush and select the Size of your 
brush. 

To make the job easier for you, select shortcut if you don’t have it. 

Here : F1 : Clear Slide / F2 : Clear Outside / F3 : Clear Slides  

Presently, you choose what you want keep (events of cavitation). For me, I click on the line, to add an 
other line I press « Maj ». I tinker with the mouse to know how I can limit the zone I want to retain. 
With F2 you delete all except your selection ; with F1, you clear all on slide and with F3 you can clear 
many slides which are going behind.  

After cleaned slides, click on the binary images, choose File -> Save as -> Tiff and after click on 
« Analyse » -> « Set Measurements » and check « Area » and « Limit to threshold », « redirect to : 
None ; Decimal : 3. 

Again Analyze -> « Set scale » and put « 1 ; 1 ; 1 and unit » in the cases, check Global.  

Then, Image -> Adjust -> Threshold -> Change factors in such as way as to black lines become red lines.  

Currently, choose OSOV -> Measure stack, you obtain numbers in a board and you register it clicking 
on File -> Save as  
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Annexe 2 : Images représentant l’observation du bout de feuille d’où sortira la sève lors de 
l’application de la pression avec la chambre à pression. On peut observer les vaisseaux à l’extrémité 
de la feuille. 
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